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Vanishing Point 

In this lesson, we’re going to continue learning about perspective, which is some-
thing that we started to cover in a previous lesson, titled “Matching Perspective.” 
Here, we will learn about the Vanishing Point filter. This will give us a lot more op-
tions when working with perspective, but it is an older filter (with less technology) 
so it will not allow us to work with more modern features like smart objects. 

Define a Plane with the Vanishing Point Filter (Timestamp 2:30)

The first thing I suggest doing before using the Vanishing Point filter is to create a 
brand new, empty layer. You can do this by clicking on the New Layer icon [+] at 
the bottom of the Layers Panel. Therefore, whatever you do with the filter will be 
deposited in this empty layer, leaving the original image layer untouched. 

You can access the filter by clicking on the Filter menu at the top of the screen and 
choosing Vanishing Point. 

Note: This filter will not be available if you are working in 16-bit mode or in a color 
space that is not RGB. If this is the case, you will see that the name of the filter is 
grayed out. 

After choosing the Vanishing Point filter, it opens a whole new window, which con-
tains the Vanishing Point settings. A Toolbar runs along the left side of the window 
and the Create Plane Tool will be active by default. This is the tool that is second to 
the top in the Toolbar and it allows you to define a surface within three-dimensional 
space. With the tool active, click on the four corners of the largest rectangle that 
is parallel with that surface. Lines will appear to show the rectangular area that is 
being defined.

In the video example, we have an image of a service station and we are going to 
use the Create Plane Tool to define the surface on the front wall of the building. We 
clicked on four corners of the rectangular front service of the building. 
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This image is open in the Vanishing Point window. The special tools related to the filter ap-
pear on the left side of the interface. In the video example, we are going to define the front, 
rectangular surface of this building as a plane. 

The Create Plane Tool (shown at left) is being used to click on the four corners of 
the rectangular surface of the building.
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After you’ve clicked on the 
fourth corner, a grid will ap-
pear over the area that has 
been defined. This grid will be 
one of three colors. If it’s red, 
it means that it’s unusable and 
the corners are probably real-
ly far off. It’s telling you that 
it doesn’t understand how the 
defined area could possibly 
be a flat surface in three-di-
mensional space. If the grid 
is yellow, it means that you’re 
getting close to a very usable 
surface, but you should ideally 
adjust the corners. If the grid 
is blue, it’s telling you that the 
area you defined is good and 
quite usable. 

After you have defined the 
space and there is a grid over 
the area, you can click and 
drag on the four corners of 
the grid in order to fine-tune 
the rectangle. When doing 
this, try to make the grid edg-
es as close to parallel with the 
lines in the image as possible. 
I like to zoom in on the image 
to make sure that things pre-
cisely line up.

When defining a plane, the grid will be one of three col-
ors. If it’s yellow, as shown above, it means that you’re 
close to defining a usable plane, but not there yet.

If the grid is blue, it means you have a usable plane. 

We’re clicking and dragging on the edge of the grid to 
extend the plane.
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Once you have defined the rectangular surface, that is the only area you will be 
able to work with. You can extend the space by clicking and dragging on the han-
dles that appear on the edges (not the corners) of the grid. When you do this, the 
perspective angles will remain the same. Knowing this, it can often times be easier 
to start off by defining a smaller space that has more easily recognizable corners 
(such as the window in the service station image) and then using the handles to 
expand the space. 

This grid causes Photoshop to be educated about the perspective in the image. It 
knows what areas are closer to the camera and therefore appear larger. It knows 
what areas are farther from the camera and therefore appear smaller. 

The Clone Stamp Tool in Vanishing Point (8:15)

One of the tools available on the left side of the Vanishing Point interface 
is the Clone Stamp Tool. You will use this tool AFTER you’ve defined a 
rectangular space. Let’s say that you want to copy an element within the 
rectangle that is close to the camera and then paste it somewhere that is farther 
from the camera. Because Photoshop knows the perspective of the image, it will 
scale the sampled element down in the perfect amount so that it looks to appear 
farther from the camera. 

In the example image, there is a sign on the building that is somewhat close to the 
camera. We activated the Clone Stamp Tool and sampled the area where the sign 
is. As we move the cursor over the area that is farther from the camera, we can see 
the preview of the sampled content becoming smaller and smaller. This preview 
appears within the circular brush tip. Photoshop is automatically scaling the con-
tent based on the perspective of the image. 

Note: To use the Clone Stamp Tool, hold down the Option key (Alt on Win) and 
click on the area you want to sample. Then release the Option key and move your 
mouse to the area where you want to paste. The preview of what you sampled will 
appear inside the brush tip. Click to paste the content. 
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When the Clone Stamp Tool is active, some settings appear in the bar above the 
image window. There are basic settings including brush size and opacity. There is 
also a Heal setting, which is set to Off by default. When the Heal menu is set to Off, 
that means that the tool is in Clone mode. When cloning, it creates an exact copy 
from the area where you sampled. If you set this menu to the Heal setting, then 
the tool will attempt to match the color and brightness of the area surrounding the 
place you are copying to. 

We mentioned earlier that you should create a new, empty layer before using the 
Vanishing Point filter. If you did that, then any retouch work that you do with the 
Clone Stamp Tool will be applied to this empty layer and not the original image lay-
er. Because it’s a separate layer, you can use a layer mask to hide and reveal parts 
of the layer. This allows the results to be more versatile. 

LEFT: The Clone Stamp Tool is being used to sample a sign on the building. CENTER: The 
Clone Stamp Tool is being used to paint in the sampled sign on another part of the building. 
RIGHT: The Heal setting (for the Clone Stamp Tool) is turned on and you can see that the 
tool attempted to match the brightness and color of the surroundings. 
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Create Multiple Planes (11:55)

Photoshop will remember the Vanishing Point plane if you leave the filter and then 
return to it. 

In the Vanishing Point window, you can 
also define additional planes. To do this, 
activate the Create Plane Tool and use it to 
click on the four corners of the next plane 
you want to define. In the video example, 
we defined another rectangular surface 
on the front of the service station image. 
After you create a rectangular plane, it au-
tomatically switches you to the Edit Plant 
Tool, which is the top tool in the Toolbar. 
This is the tool that you use to grab the 
corners or sides of the plane to adjust the 
position. If you want to create additional 
planes, you will need to return to the Cre-
ate Plane Tool for each one. 

A second plane is being created for another  
surface of the building.

This is an example of an instance where it was easier to start with a smaller plane (a group of 
bricks, shown at left) and then expand the sides to create the larger plane we truly need.
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The Marquee Tool within the Vanishing Point Filter (18:36)

After you have created planes that educate Photoshop as to what the correct per-
spective is, the tools within the Vanishing Point filter will take that perspective into 
consideration when doing their job. You already saw this with the Clone Stamp 
Tool. When cloning from one area (within a plane) to another, it will automatically 
scale the content based on the perspective. 

The Marquee Tool works in a sim-
ilar way. The Marquee Tool is the 
third tool in the Toolbar and it can 
be used to make rectangular se-
lections within a plane. When you 
use the tool to click and drag out 
a selection, it will make that se-
lection based on the perspective 
of the image. I like to make the 
selection slightly larger than the 
area I need because I would rath-
er use a layer mask to truly get 
that edge to be precise.

After creating the selection, you will notice that the Move Tool is not available. In 
order to move a copy of the selected area, hold down the Option key (Alt on Win) 
and then click and drag on the object. You can move it to a location within the 
same plane or you can drag it to a different plane. 

The Marquee Tool (Shown at left) is being 
used to make a selection of the orange sign.

After the sign was selected, we moved it to another plane by holding down the Option key 
(Alt on Win) and then clicking and dragging it to the other wall. 
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When you drag a selected ob-
ject to another plane, you may 
find that the object becomes 
flipped horizontally or vertical-
ly. This could happen if the two 
planes were defined differently. 
An example of this would be if 
you defined plane one by click-
ing on the corners in a clockwise 
manner and then defined plane 
two by clicking on the corners in 
a counter-clockwise manner. If you copied the contents of a selection from plane 
one to plane two, the contents would be flipped horizontally. You can correct for 
this using the Transform Tool, which is located within the Toolbar. When the Trans-
form Tool is active, there will be two checkboxes in the settings bar above the im-
age window. The “Flip” check box will flip the contents of the selection horizontally. 
The “Flop” check box will flip the contents of the selection vertically. 

When using the Transform Tool, handles will 
appear outside of the selected area and you 
can click and drag on these handles to re-
size the area. Click and drag on the top and 
bottom handles to make the selected con-
tent taller or shorter. Click and drag on the 
left and right handles to make the selected 
content wider or narrower. Click and drag on 
the corner handles to scale both the height 
and width of the content. When you’re done, 
click OK to exit the Vanishing Point window. 

When we moved the contents of a selection between 
planes, it became flipped. To fix it, we activated the  
Transform Tool and turned on the “Flip” setting.

The Transform Tool handles are being 
used to adjust the height of the sign.
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If you had created a brand new layer to work on, the copied area will appear on this 
layer, leaving the original image untouched. It’s useful to have this content on its 
own layer because you can use a layer mask to determine how much of it should 
be visible. 

Using Vanishing Point to Retouch Out a Sign (24:15)

In the next example image, 
we are going to remove a 
sign from a brick wall. The 
wall starts very close to the 
camera and then trails off into 
the distance, so we’re going 
to need to match the per-
spective of the sample area 
in order to paste it over the 
sign. The first thing we’ll do 
is create a new, empty layer 
on which to place our retouch 
work. 

The copy of the sign was placed on its own layer. Here, we added a layer mask and we’re 
painting on the mask in order to fine-tune the edge of the sign layer.

We’re going to use the Vanishing Point filter to remove 
the sign on the wall.
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We’ll set the perspective in the image using the Create Plane Tool within the Van-
ishing Point Filter. There are no large, rectangular planes to use, but that’s ok. We 
can find vertical and horizontal surfaces by using the grout lines of the wall bricks. 

After defining the rectangular plane, it will automatically switch to the Edit Plane 
Tool so we can drag the handles to fine-tune the position of the edges. We’ll click 
and drag down on the handle that’s on the bottom edge of the plane (not a corner 
handle). We want to make sure that the entire sign is contained within the plane. 
We’ll also drag the left and right edges out to include any bricks we might want to 
sample from. 

The Create Plane 
Tool was used to 
define the wall. We 
used the vertical 
grout lines in the 
wall as guides.

The Edit Plane Tool 
is being used to 
extend the plane to 
include the entire 
sign and more of 
the bricks.
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Next, we’ll activate the Clone Stamp Tool and we’ll use it to sample from an area of 
brick on the left part of the wall. When we sample, we’ll click at a cross-section of 
the grout lines in the bricks so that we have something to align with when pasting 
the content. Then, we’ll align that sample area (you can see a preview within the 
brush tip) with a cross-section of brick next to the sign and we’ll start to paint. As 
we paint over the sign, Photoshop will use the perspective of the image to scale 
the content proportionally. 

After using the Clone Stamp Tool with the Heal setting turned off, I like to turn it 
on and go over some areas again. With the Heal setting on, it will attempt to match 
the brightness of the surrounding area.

The Brush Tool I wanted to note that there is also a Brush Tool within the Vanishing 
Point filter and it can be used to apply paint to the defined plane. When the tool 
is active, the color can be chosen in the settings bar above the image. When you 
paint, the brush tip will scale up and down in order to match the perspective of the 
image. If you were to click in and area that is close to the camera and then paint a 
line in the direction that moves away from the camera, you will see that the paint 
stroke becomes smaller and smaller. 

The Clone Stamp Tool is being used to remove the sign. You can see the crosshair for the 
sample area (on the left) and the crosshair for the tool tip that is removing the sign.
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Using Vanishing Point to Match Angles Between Images (32:42)

In the next image, we want to take the circular logo from the top of a gas pump in 
one image and apply that logo to a gas pump in another image. The gas pumps are 
at different angles, so we’re going to use Vanishing Point to help match things up. 

We’ll start with the image that has the logo we want to copy. We’ll create a new, 
empty layer and then open the Vanishing Point filter. 

The logo is at an angle and it’s 
circular, so it’s going to be diffi-
cult to establish the perspective 
by using that area. Instead, we’ll 
look for a rectangular area that 
will be easier to define. It will have 
the same perspective as the logo. 
We’ll use the two rectangular gas 
pumps combined. We’ll activate 
the Create Plane Tool and click 
on the four corners.

In this example, we’re going to take the logos from the pumps on the right and apply them to 
the pumps on the left.

The Create 
Plane Tool 
is being 
used to 
define a 
rectangular 
area.
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If the grid is not blue, we’ll use the Edit Plane Tool to click and drag on the corner 
and/or edge handles to adjust the plane so that the grid becomes blue. We’ll drag 
on the edge handles to ensure that the plane encompasses the top pump logos 
because these are what we want to copy.

All we needed to do in this image was create the perspective grid. Now, we will 
click the little hamburger menu in the top left part of the settings bar and choose 
“Render Grids to Photoshop.” We’ll click OK to exit the Vanishing Point filter. 

After defining the plane, we are choosing the “Render Grids to Photoshop” option before 
closing the Vanishing Point window.
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Back in the main area of Photoshop, the 
empty layer we created will now contain 
the Vanishing Point Grid. We’re going to 
use this grid, in conjunction with the Per-
spective Crop Tool, to isolate and straight-
en the pump. We’ll activate the Perspective 
Crop Tool and click around the four corners 
of the circular logo. The circular logo obvi-
ously doesn’t have corners, but we can use 
that perspective grid as a guide in order to 
click in the correct places. 

After defining the crop, handles will ap-
pear around the corners of the rectan-
gle and we can use these to fine-tune the 
crop. We’ll make sure that the crop edges 
are aligned vertically and horizontally with 
the perspective grid. Then, we can drag the 
sides of the crop to make sure that they 
encompass the logo. 

When we tap the Return/Enter key, it will crop the image AND straighten the re-
sult. We can now discard the grid layer because we no longer need it. This isolated, 
straightened logo is now what we need for pasting into the other image. 

We’ll select all (Command+A, Ctrl+A on 
Win) and then copy (Command+C, Ctrl+C 
on Win). Then we’ll open the image in 
which we want to place the logo. We’ll 
make a small selection where we’d like the 
logo to go. Then, we’ll click on the Edit 
menu and choose Paste. The logo will be 
pasted into the document on a new layer 
and centered on the selection. 

The Perspective Crop Tool is being used to 
define a rectangle around the logo.  
The Vanishing Point grid is being used  
as a guide.

The isolated, straightened logo was pasted 
into the other document.
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Before making any transformations to the layer we’ll convert it into a Smart Object 
by clicking on the Layer menu and choosing Smart Objects > Convert to Smart 
Object. 

It’s difficult to tell exactly what angle the logo should be at because we’re placing 
it on a round surface. To help with that, we’ll follow the same process to put a grid 
on this image. We’ll temporarily hide the visibility of the logo layer and we’ll create 
a new, empty layer on which to place the grid. 

We’ll open the Vanishing Point filter and make sure the Create Plane Tool is active. 
We need to find a rectangular area that we can use to define the perspective plane. 
We’ll use the combined rectangular gas pumps. We’ll use the Create Plane Tool 
to click on the four corners of the rectangle, making sure that the resulting grid is 
blue. After we’ve fine-tuned the grid, we can click on the side handles to extend the 
grid up so that it encompasses the round pump toppers. This is where we want to 
place the logo. 

LEFT: In the Vanishing Point filter, the Create Plane Tool was used to create a rectangle 
around the gas pumps. RIGHT: The Edit Plane Tool is being use to extend the plane so that it 
includes the round pump toppers. 
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Once we have this grid, we’ll click on the little hamburger menu in the settings bar 
and we’ll choose Render Grid to Photoshop. Then we’ll click the OK button to exit 
the filter and return to Photoshop’s main interface. The grid we just created will be 
contained on the empty layer we added before entering Vanishing Point. 

We’ll turn the visibility back on for the 
logo layer (which we had turned into a 
smart object) and we’ll move it to the 
top of the layer stack. We want to dis-
tort the logo to match the perspective 
of the grid so we’ll click on the Edit menu 
and choose Transform > Distort. Distort 
handles will appear around the layer. We 
want to click and drag on these handles 
so that the edges of the layer become 
parallel with the horizontal and vertical 
lines on the grid. Then, we’ll again click 
on the Edit menu and choose Trans-
form > Scale. The transform handles will 
still appear on the layer and we can now 
use them to scale the logo so that it fits 
inside the gas pump topper. 

It may be difficult to see how the lay-
er we’re scaling relates to the underly-
ing image. If that’s the case, you could 
either lower the opacity of the layer or 
change its blending mode. In the vid-
eo example, we changed the blending 
mode to Multiply so that we could see 
the underlying image as well. Now, we 
can use the transform handles to scale 
the logo so that it fits. 

We are transforming the logo layer to match 
the angle of the perspective grid.

The blending mode of the logo layer was 
changed to Multiply. This allows us to see the 
underlying layer as we scale the logo.
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By default, the Transform command will scale the logo proportionately. If we need 
to scale the width but not the height (or vise versa), we can hold down the Shift 
key while dragging the side handles of the layer. Once the logo has been scaled, 
we’ll tap the Return/Enter key to lock in the transformation and remove the trans-
form handles. We can now discard the grid layer because we no longer need it. 
We’ll set the blending mode of the logo layer back to normal. 

In retouching the logo, we want to copy from the logo layer and apply it to the 
image. We’ll create a brand new, empty layer at the top of the layer stack on which 
to apply our retouching. 

Now we want to start pasting the logo onto that new, empty layer, but we do not 
want to see the logo layer while we’re painting in the content (it would obstruct the 
area we’re painting). In order to do this, we can trick Photoshop by hiding the logo 
layer at the bottom of the layer stack. If the bottom layer is a locked background 
layer, we can double-click on it to unlock it. Then, we can place the logo layer be-
neath it. 

Photoshop is not going to like that the sampled layer is a smart object, so we’ll click 
on the Layer menu and choose Smart Objects > Rasterize. This will make it so the 
layer is no longer a smart object. (We had only converted it into a smart object so 
that we could scale and distort without losing quality.)

In order to apply the logo, we’re going to use the Healing Brush, which is going to 
attempt to match the brightness and color of the image that’s underneath.  With 
the Healing Brush active, we need to specify some settings in the Options Bar 
above the image window. We’ll set the Sample menu to Current & Below. This 
will make it so that we can copy from all the underlying layers even though we 
are working on an empty layer at the top of the layer stack. We’ll also turn on the 
“Aligned” check box. 
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We’ll make sure that the logo layer is ac-
tive and that the visibility of all other layers 
are turned off.  We’ll sample the logo by 
holding down the Option key (Alt on Win) 
and clicking within the center of the logo. 
Then, without moving the mouse, we’ll re-
lease the Option key and click in the exact 
same spot. We’ll immediately choose the 
Undo command. This might sound like an 
odd step, but what we’re doing is defining 
the position that the tool will use in past-
ing the sampled content. 

Then, we’ll turn the visibility of the image 
layer and the top layer back on and we’ll 
make sure that the top, empty layer is ac-
tive. This is where we’re going to apply the 
retouching. As we move the round cursor 
over the gas pump topper, we can see a 
preview of what we’re about to paste with-
in the brush tip. We’ll start to paint in the 
logo, making sure that we’re being precise 
and not extending outside the white cir-
cle. We’ll need to do this as a single paint 
stroke because we’re using the Healing 
Brush. 

If the end result is a little too bright or too 
dark, we could adjust it using a Curves ad-
justment. 

With the Healing Brush active, we are  
sampling the center of the logo layer.

The Healing Brush is being used to paint in 
the sampled logo. We’re being careful to not 
extend into the black outline.


